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Bold
Bold type represents the names of commands and 
options that you interact with. Bold type also indicates 
text and numbers that you must type into a dialog box 
or window.

Italics
Italic words introduce a new term and are followed by a 
definition.

Numbered Steps
You must perform the instructions in numbered steps in 
order to successfully complete a section and achieve the 
final results.

Bulleted Steps
These steps point out various optional features. You
do not have to perform these steps; they simply give 
additional information about a feature. Steps without 
bullets tell you what the program does in response to 
your following a numbered step. For example, if you click 
a menu command, a dialog box may appear or a window 
may open. The step text may also tell you what the final 
result is when you follow a set of numbered steps.

Notes
Notes give additional information. They may describe 
special conditions that may occur during an operation. 
They may warn you of a situation that you want to 
avoid – for example, the loss of data. A note may also 
cross reference a related area of the book. A cross 
reference may guide you to another chapter or another 
section within the current chapter.

Icons and buttons
Icons and buttons are graphical representations within the 
text. They show you exactly what you need to click to 
perform a step.

You can easily identify the tips or warnings in any section 
by looking for the Tip and Warning icons. Tips offer 
additional information, including tips, hints, and tricks. You 
can use the tip information to go beyond what you have 
learned in the steps. Warnings tell you about solutions to 
common problems and general pitfalls to avoid.

Do you look at the pictures in a book or magazine before 
anything else? Would you rather be shown instead of 
read about how to do something? Then this book is for 
you. Opening Simply Office 2010 allows you to read less 
and learn more about the Windows operating system.

Who Needs This Book
This book is for a reader who has never used this 
particular technology or application. It is also for more 
computer literate individuals who want to expand their 
knowledge of the different features that Windows has 
to offer. 

Using the Mouse
This book uses the following conventions to describe the 
actions you perform when using the mouse:

Click
Press your left mouse button once. You generally click 
your mouse on something to select something on the 
screen.

Double-click
Press your left mouse button twice. Double-clicking 
something on the computer screen generally opens 
whatever item you have double-clicked.

Right-click
Press your right mouse button. When you right-click 
anything on the computer screen, the program displays 
a shortcut menu containing commands specific to the 
selected item.

Click and Drag, and Release the Mouse
Move your mouse pointer and hover it over an item on 
the screen. Press and hold down the left mouse button. 
Now, move the mouse to where you want to place the 
item and then release the button. You use this method to 
move an item from one area of the computer screen to 
another.

The Conventions in This Book
A number of typographic and layout styles have been 
used throughout Simply Office 2010 to distinguish 
different types of information.

How to Use This Book

01_711293-ffirs.indd   v01_711293-ffirs.indd   v 6/24/10   8:34 PM6/24/10   8:34 PM



CONTENTS

Table of Contents

I OFFICE FEATURES 2
Chapter 1: Office Basics
 4 Start and Exit Office Applications

 6 Navigate the Program Windows

 8 Work with the Ribbon

 10 Customise the Quick Access Toolbar

 12 Get Help with Office

Chapter 2: Working with Files
 14 Create a New File

 16 Save a File

 18 Open a File

 20 Print a File

 22 Select Data

 24 Cut, Copy and Paste Data

Chapter 3: Office Graphics Tools
 26 Insert a Picture or Clip Art

 28 Resize and Move Objects

 30 Rotate and Flip Objects

 32 Crop a Picture

 34 Change a Picture

02_711293-ftoc.indd   vi02_711293-ftoc.indd   vi 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS

Chapter 4: Adding Text
 38 Change Word’s Views

 40 Type and Edit Text

 42 Insert Symbols and Special Characters

Chapter 5: Formatting Text
 44 Change the Font, Size and Colour

 46 Align Text

 47 Set Line Spacing

 48 Indent Text

 50 Set Tabs

 52 Set Margins

 54 Copy Formatting

 55 Clear Formatting

 56 Format with Styles

 58 Apply a Template

Chapter 6: Adding Extra Touches
 60 Create Columns

 62 Insert a Table

 64 Use Headers, Footers and Footnotes

 66 Insert Page Numbers and Page Breaks

 68 Create an Index

 70 Create a Table of Contents

II WORD 36

02_711293-ftoc.indd   vii02_711293-ftoc.indd   vii 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS

Chapter 8: Building Spreadsheets
 82 Enter Cell Data

 84 Select Cells

 86 Faster Data Entry with AutoFill

 88 Change the Font and Size

 89 Change Number Formats

 90 Apply Conditional Formatting

 92 Add Columns and Rows

 94 Freeze a Column or Row

 95 Name a Range

 96 Delete Data or Cells

Chapter 9: Worksheet Basics
 98 Add a Worksheet

 99 Name a Worksheet

 100 Change Page Setup Options

 102 Move and Copy Worksheets

 103 Delete a Worksheet

 104 Find and Replace Data

 106 Sort Data

 108 Filter Data

III EXCEL 80

Chapter 7: Reviewing Documents
 72 Find and Replace Text 

 74 Check Spelling and Grammar

 76 Work with AutoCorrect

 78 Track and Review Document Changes

02_711293-ftoc.indd   viii02_711293-ftoc.indd   viii 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS

Chapter 10: Working with Formulas and Functions
 110 Create a Formula

 112 Apply Absolute and Relative Cell References

 114 Understanding Functions

 116 Apply a Function

 118 Total Cells with AutoSum

 119 Audit a Worksheet for Errors

 120 Create a Chart

Chapter 11: Creating a Presentation
 124 Create a Photo Album Presentation

 126 Create a Presentation with a Template

 127 Build a Blank Presentation

 128 Change PowerPoint Views

 130 Insert Slides

 131 Change the Slide Layout

Chapter 12: Populating Presentation Slides
 132 Add and Edit Slide Text

 134 Change the Font, Size and Colour

 138 Set Line Spacing

 139 Add a Text Box to a Slide

 140 Add Other Objects to a Slide

 142 Move a Slide Object

 143 Resize a Slide Object

IV POWERPOINT 122

02_711293-ftoc.indd   ix02_711293-ftoc.indd   ix 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS

Chapter 14: Database Basics
 152 Create a Database Based on a Template

 154 Create a Blank Database

 156 Create a New Table

 158 Change Table Views

 160 Add or Move a Field in a Table

 161 Delete or Hide a Field in a Table

 162 Create a Form

 164 Change Form Views

 165 Move or Delete a Field in a Form

Chapter 15: Adding, Finding and Querying Data
 166 Add a Record to a Table

 168 Add a Record to a Form

 170 Navigate Records in a Form

 171 Search for a Record in a Form

 172 Sort Records

 174 Filter Records

 176 Use Conditional Formatting

 178 Perform a Simple Query

 180 Create a Report

V ACCESS 150

Chapter 13: Assembling and Presenting a Slide Show
 144 Reorganise Slides

 146 Record Narration

 147 Set Up a Slide Show

 148 Run a Slide Show

02_711293-ftoc.indd   x02_711293-ftoc.indd   x 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS

VI OUTLOOK 184
Chapter 16: Organising with Outlook
 186 View Outlook Components

 188 Schedule an Appointment

 190 Schedule an Event

 192 Create a New Contact

 194 Create a New Task

Chapter 17: E-mailing with Outlook
 196 Compose and Send a Message

 198 Send a File Attachment

 199 Read an Incoming Message

 200 Reply To or Forward a Message

 202 Add a Sender to Your Outlook Contacts

 203 Delete a Message

 204 View Conversations

 206 Screen Junk E-mail

INDEX 208

02_711293-ftoc.indd   102_711293-ftoc.indd   1 6/24/10   8:35 PM6/24/10   8:35 PM



CONTENTS
4 Chapter 1

Office Basics

14 Chapter 2
Working with Files

26 Chapter 3
Office Graphics Tools

03_711293-pp01.indd   203_711293-pp01.indd   2 6/24/10   8:35 PM6/24/10   8:35 PM



I
OFFICE FEATURES

In Office 2010, the applications share a common look and 
feel. You can find many of the same features in each program, 

such as the Ribbon, the Quick Access toolbar, various 
program window controls and the File tab. Many of the tasks 

you perform in Office, such as creating new files, opening 
existing files, working with text and data in files, saving files, 

printing files and executing commands, involve similar 
processes and features throughout the Office suite. In this 

part, you learn how to navigate the common Office features 
and perform basic Office tasks.
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CHAPTER 1 OFFICE BASICS

START AND EXIT OFFICE APPLICATIONS

Before you can begin working with a Microsoft Office application, also called a program, you 
must open the application.

There are a few ways to start an application. One is to launch it from the Start menu, as 
described in this task. Another is to double-click the program’s shortcut icon on the desktop.

When you finish your work, you can close the program. If applicable, you can save your work 
before exiting a program completely.

Start an Office Application
 11 Click Start.

 22 Click All Programs. 

Note: The All Programs menu option 
changes to a Back menu option.

 33 Click Microsoft Office.

 44 Click the name of the program 
that you want to open.

 AA The program that you selected 
opens in a new window.

Note: See the next section to learn how to 
identify different areas of the program 
window.

33

4

2

1

AA

04_711293-ch01.indd   404_711293-ch01.indd   4 6/24/10   8:36 PM6/24/10   8:36 PM



5

CHAPTER 1 OFFICE BASICS

Exit an Office Application
 11 Click the Close button ( ).

 AA You can also click the File tab 
and then click Exit.

  If you have not yet saved your 
work, the program prompts you 
to do so before exiting.

 22 Click Save.

  The program window closes.

 BB If you click Don’t Save, the 
program closes without saving 
your data.

 CC If you click Cancel, the 
program window remains open.

Create a Shortcut Icon for an 
Office Application
 11 Right-click a blank area of the 

desktop and click New and then 
Shortcut.

  The Create Shortcut dialog box 
appears.

 22 Click Browse, navigate to the 
Office program, click the filename 
and click OK.

 33 Click Next.

 44 Type a name for the shortcut.

 55 Click Finish.

  The new shortcut icon appears on 
the desktop.

CC

B
2

A

22

4
3

5
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CHAPTER 1 OFFICE BASICS

 AA Title Bar
Displays the name of the open file and 
the Office program.

 BB Quick Access Toolbar
Displays quick access buttons to the 
Save, Undo and Redo commands.

 CC File Tab Menu
Displays a menu of file commands, such 
as New and Open.

 DD Ribbon
Displays groups of related commands 
in tabs. Each tab offers buttons for 
performing common tasks.

 EE Status Bar
Displays information about the current 
worksheet or file.

 FF Program Window Controls
Displays buttons to minimise the 
program window, restore the window 
to full size and close the window.

All Office programs share a common appearance and many of the same features. These 
features include a Ribbon, which appears instead of the menus and toolbars found in 
previous versions of Microsoft Office; a Quick Launch toolbar, which features a customisable 
set of frequently used commands; and scroll bars, which you can use to navigate an open file 
in a program window. When you learn how to navigate one Office program, you can use the 
same skills to navigate the others. If you are new to Office, you should take a moment to 
familiarise yourself with the suite’s various on-screen elements.

NAVIGATE THE PROGRAM WINDOWS

AA

E

C
B

D

F
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7

CHAPTER 1 OFFICE BASICS

 AA Formula Bar
This appears only in Excel. Use this bar 
to type and edit formulas and perform 
calculations on your worksheet data.

 BB Work Area
The area where you add and work 
with data in a program. Depending on 
the Office program, the work area may 
be a document, a worksheet or a slide.

 CC Document Window 
Controls

Use these buttons to minimise or 
restore the current document within 
the program window.

 DD Zoom Controls
Use this feature to zoom your view of 
a document.

 EE Scroll Bars
Use the vertical and horizontal scroll 
bars to scroll through the item shown 
in the work area.

CC

B

D

A

E

E
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CHAPTER 1 OFFICE BASICS

 22 Click a button to activate a 
command or feature.

 AA Buttons with arrows display 
additional commands.

 BB With some groups of 
commands, you can click the 
corner group button ( ) to 
display a dialog box of 
additional settings.

  When you position the mouse 
pointer over Live Preview options 
on the Ribbon, you see the results 
in the document before applying 
the command.

Use the Ribbon
 11 Click a tab.

  The tab organises related tasks 
and commands into logical groups.

Instead of the menus and toolbars found in earlier versions of Office, Office 2010 features 
the Ribbon, which offers an intuitive way to locate and execute commands.

The Ribbon is grouped into tabs, each containing groups of related commands. For example, 
the Home tab in Microsoft Word contains commands for changing the font, setting text 
alignment, indenting text and so on. Some tabs appear only when needed, such as when you 
are working with a table or picture in a document.

The Ribbon is maximised by default, but you can minimise it to view more of your program 
window.

WORK WITH THE RIBBON

11

AA

2
B
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 22 Double-click the tab name again 
to maximise the Ribbon.

Minimise the Ribbon
 11 Double-click a tab name.

  The Ribbon is minimised.

11

22

11

2

Keep the Ribbon Minimised
 11 Right-click a tab on the Ribbon.

 22 Click Minimize the Ribbon.

  The program’s Ribbon is 
minimised at the top of the 
screen.

  To use a Ribbon while it is 
minimised, simply click the tab 
containing the tools that you 
want to access.
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CHAPTER 1 OFFICE BASICS

 11 Click the Customize Quick 
Access Toolbar button ( ).

 22 Click More Commands.

 AA You can click any of the 
common commands to add 
them to the toolbar.

 BB You can click Show Below 
the Ribbon if you want to 
display the toolbar below the 
Ribbon.

  The Options dialog box opens 
with the options to customise the 
Quick Access Toolbar shown.

 33 Click the Choose commands 
from .

 44 Click a command group.

The Quick Access toolbar, which appears on-screen regardless of what tab is currently 
shown in the Ribbon, offers quick access to the Save, Undo and Redo commands.

You can customise this toolbar to include other commands, such as the Quick Print 
command or another command you use often. Alternatively, you might customise the 
toolbar to omit commands that appear by default.

By default, the Quick Access toolbar appears in the top left corner of the program window, 
above the Ribbon. You can choose to display the toolbar below the Ribbon instead.

CUSTOMISE THE QUICK ACCESS TOOLBAR

BB

A

1

2

33

4
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 To remove a button from the 
Quick Access toolbar, open the 
Options dialog box, click the 
command name in the list box 
on the right, click the Remove 
button and click OK. The button 
no longer appears on the 
toolbar.

 DD The new command appears 
on the Quick Access toolbar.

 55 Click the command that you want 
to add to the toolbar.

 66 Click the Add button.

 CC Office adds the command.

  You can repeat Steps 3 to 6 to 
move additional buttons to the 
toolbar.

 77 Click OK.

CC

6

7

5

DD

 You can add commands to 
the toolbar directly from the 
Ribbon. Simply click the tab 
containing the command that 
you want to add, right-click the 
command and then click Add 
to Quick Access Toolbar. The 
command is immediately added 
as a button on the toolbar.
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